4.2.4.5  ACCESSING THE IMAGE VIEWER WINDOW ZOOM DROP-DOWN MENU

  To access the Zoom drop-down menu on the Image Viewer window:

  a.  Select Zoom from the menu bar by clicking on it with the mouse or by depressing ALT and Z on your keyboard.  The Zoom drop-down menu in Figure 4.2.4.5 appears.  (The icons for some of the options may also be selected directly from the toolbar.)
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       FIGURE 4.2.4.5 - IMAGE VIEWER WINDOW (ZOOM DROP-DOWN MENU)

  b.  Select the desired option described in table below.  The table lists the functions on the Zoom drop-down menu of the Image Viewer window. 

  c.  Zoom drop-down menu options for the Image Viewer window:

ZOOM MENU OPTIONS       PERFORM THESE FUNCTIONS
Zoom: Zoom In           Zooms in by 5% on the current page to make the 

                        image larger.

Zoom: Zoom Out          Zooms out by 5% on the current page to make the 

                        image smaller. 

ZOOM MENU OPTIONS       PERFORM THESE FUNCTIONS
Zoom: Zoom to           Zooms in on a selected area to enlarge it to 

Selection               fill the screen.  (To select a portion of an 

                        image, use the Select Image option on the Edit 

                        drop-down menu.)

Zoom: Fit Width         Fits the width of the image page to the width 

                        of the screen.

Zoom: Fit Height        Fits the height of the image page to the height 

                        of the screen.

Zoom: Actual Size       Displays the image in its actual size.

Zoom: Custom            Displays a box where the scale percentage for 

                        the image may be typed in or selected from a 

                        drop box.  The typed in percentage may be any 

                        number up to three digits long.  The drop box 

                        contains percentages between 25% and 400%.

4.2.4.6  ACCESSING THE IMAGE VIEWER WINDOW ANNOTATIONS DROP-DOWN MENU

  To access the Annotations drop-down menu:

  a.  Select Annotations from the menu bar by clicking on it with the mouse or by depressing ALT and A on your keyboard.  The Annotations drop-down menu in Figure 4.2.4.6 appears.
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   FIGURE 4.2.4.6 - IMAGE VIEWER WINDOW (ANNOTATIONS DROP-DOWN MENU)

  b.  Select the desired option described in table below.  The table lists the functions on the Annotations drop-down menu of the Image Viewer window. 

  c.  Annotations drop-down menu options for the Image Viewer window:

ANNOTATIONS MENU OPTIONS            PERFORM THESE FUNCTIONS
Annotations: Select Annotations     Highlights annotations.  To delete

                                    an annotation, highlight the 

                                    annotation and depress the Delete 

                                    key.

Annotations: Show Annotations       Displays the annotations made to 

                                    a file.  If Show Annotations is 

                                    selected, the system displays a 

                                    check beside the Show Annotations 

                                    Option as shown in Figure 4.2.4.6.

                                    Reselect the option to turn off 

                                    the Show Annotations option. 

                                    The check mark will disappear.

Annotations: Make Annotations       Makes the annotations (for 

Permanent                           example notes, rubber stamps, 

                                    highlighting, etc.) permanent.  

                                    Unless the image is in color, the 

                                    annotations will become black and 

                                    white once they are made permanent.

Annotations: Highlighter            Highlights an area in the image

                                    file.

Annotations:  Freehand Line         Allows drawing in the image file.

Annotations:  Straight Line         Makes a straight line in the image 

                                    file.  

Annotations:  Hollow Rectangle      Makes a hollow rectangle in an 

                                    image file.  The image file shows 

                                    through the rectangle.  

Annotations: Filled Rectangle       Makes a filled rectangle in an 

                                    image file.

Annotations: Typed Text             Inserts text into the image file.

Annotations: Attach a Note          Inserts highlighted text into the 

                                    image file.

Annotations: Text from File         Places text from a .txt file into 

                                    the image file.

Annotations: Rubber Stamps          Rubber stamps the image file.  

                                    Design your own rubber stamps.

                                    For example, mark a file confi-

                                    dential, draft, final, etc.  You 

                                    have the option to make the date 

                                    and time part of your stamp.  This 

                                    option also allows you to modify 

                                    existing stamps.

ANNOTATIONS MENU OPTIONS            PERFORM THESE FUNCTIONS
Annotations: Properties             Displays the Annotation Tools 

                                    window.  Select the tool you wish 

                                    to use.  Choices are:  Highlighter, 

                                    Freehand Line, Straight Line, 

                                    Hollow Rectangle, Filled Rectangle, 

                                    Typed Text, Attach-A-Note, Text 

                                    From File, and Rubber Stamp. 

4.2.4.7  ACCESSING THE IMAGE VIEWER WINDOW HELP DROP-DOWN MENU

  To access the Help drop-down menu:

  a.  Select Help from the menu bar by clicking on it with the mouse or by depressing ALT and H on your keyboard.  The Help drop-down menu in Figure 4.2.4.7A appears.  (Some help options may be accessed through tool bar icons.)
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      FIGURE 4.2.4.7A - IMAGE VIEWER WINDOW (HELP DROP-DOWN MENU)

  b.  Select the desired option described in table below.  The table lists the functions on the Help drop-down menu of the Image Viewer window. 

  c.  Help drop-down menu options for the Image Viewer window:

HELP MENU OPTIONS                   PERFORM THESE FUNCTIONS
Help: Contents                      Displays the Help Table of 

                                    Contents.

Help: Search                        Allows the help to be searched 

                                    for a specific word or topic.  

Help: About Image Viewer            Displays the About Item Folder 

                                    window in Figure 4.2.4.7B below.  

                                    The window lists the developer, 

                                    the version number of the appli-

                                    cation, and the environment 

                                    required to run the application. 
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               FIGURE 4.2.4.7B - ABOUT ITEM DATA FOLDER

4.2.5  CONFIGURING THE FOLDERS APPLICATION WITH PASSWORDS FOR OTHER 

       SYSTEMS

  a.  Use this option to enter your logins for the Federal Logistics Information System (FLIS) Total Item Record (TIR), the Standard Automated Materiel Management System (SAMMS), and the Automated Inventory Manager System (AIMS).  The Folders application saves these logins.  The only time you would need to reconfigure the logins would be if your Login, your password, or the DSN changes.  The folders application saves these passwords and uses them when you request information from SAMMS, AIMS, or the TIR

  b.  To complete the login information:

    (1) Select the Configuration option from the File drop-down menu.  The system displays the Login Configuration window.  
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               FIGURE 4.2.5 - LOGIN CONFIGURATION WINDOW

    (2) Click on the TAB for the system password that you wish to input.  Select SAMMS, AIMS, or TIR.

    (3) Type in the Login, the Password, and the DSN (Internet Protocol (IP) Address) for the selected system. 

    (4) Repeat steps b and c for each system above for which you have a login.

4.2.6  EXITING THE DSE – ITEM DATA APPLICATION

  To exit the DSE – Item Data application, you must first exit all open  Item Data windows until you reach the DSE – Item Data window.  See sections 4.2.6.1 and 4.2.6.2 below.

4.2.6.1  TO EXIT A DSE – ITEM DATA WINDOW

  To exit a DSE – Item Data window:

  a.  Select File from the menu bar by clicking on it or by depressing  ALT and F at the same time.  A drop-down menu appears.  (Or click on the X in the upper right hand corner of the window and go to step c.) 

  b.  Select Exit by clicking on it or by depressing the X key.  Depending on where you are in the application, you may be given the option to save changes.  For example, if you are exiting the Image Viewer window, a pop-up message appears giving you the option to save changes before exiting the window.
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            FIGURE 4.2.6.1 - SAMPLE SAVE FILE POP-UP MESSAGE

  c.  Click YES to save changes.  Click NO to exit the window without saving changes.  Click CANCEL to discontinue the action.

NOTE:  When you exit many of the DSE – Item Data windows, a message SAVE CHANGES? YES NO CANCEL appears.  This window appears even if no changes have been made to the table.

4.2.6.2  TO EXIT THE DSE – ITEM DATA APPLICATION

  To exit the DSE – Item Data Application:

  a.  Select File from the menu bar on the DSE – Item Data Menu window (Figure 4.2) by clicking on it or by depressing the ALT and F at the same time.  A drop-down menu appears.  See step b (or click on the X in the upper right hand corner of the window).

  b.  Select the Exit option by clicking on it or by depressing X.  You immediately exit the DSE – Item Data application, without a message being displayed. 

4.3  ACCESSING EDIT OPTIONS ON THE DSE – ITEM DATA WINDOW

  This menu bar option is not currently functional and may be removed from the menu bar.  All choices on the drop-down menu are grayed out.

4.4  ACCESSING FORMS OPTIONS ON THE DSE – ITEM DATA WINDOW

  To access Forms options:

  a.  On the DSE – Item Data window, select Forms from the menu bar by using the mouse to click on the Forms option or by depressing ALT and O on your keyboard.  The drop-down menu in Figure 4.4 appears.  The icons listed by the forms on the drop-down menu are also listed on the toolbar.  Once you know the icon for a form, you may click directly on the icon on the tool bar to select the form.
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   FIGURE 4.4 - DSE – ITEM DATA WINDOW FORMS DROP-DOWN MENU AND TOTAL 

                ITEM RECORD SUBMENU

  b.  Select the desired option from the table below.  The table lists the functions on the Forms drop-down menu of the DSE – Item Data window. 

FORMS MENU OPTIONS                PERFORM THESE FUNCTIONS
Forms: New Search Key             Allows you to change the NSN used for 

                                  querying forms.

Forms: AIMS Buy History           Displays the AIMS Buy History window 

                                  for the selected NSN.  (The selected 

                                  NSN is displayed on the left corner 

                                  of the status bar.)

Forms: Active Contract File       Displays the Active Contract File Inq 

Inquiry                           window for the selected NSN.  (The  

                                  selected NSN is displayed on the left  

                                  corner of the status bar.)

Forms: Active Purchase            Displays the Active Purchase Request  

Request Inquiry                   window for the selected NSN.  (The  

                                  Selected NSN is displayed on the left  

                                  corner of the status bar.)

FORMS MENU OPTIONS                PERFORM THESE FUNCTIONS
Forms: Current On Hand Stock      Displays the Current on Hand Stock 

                                  window for the selected NSN.  (The 

                                  selected NSN is displayed on the 

                                  left corner of the status bar.)

Forms: Customer/Depot             Displays the Customer/Depot 

Complaints History                Complaints History window for 

                                  the selected NSN.  (The selected 

                                  NSN is displayed on the left 

                                  corner of the status bar.)

Forms: Customer Returns           Displays the Customer Returns 

History Process                   History Process for the selected 

                                  NSN.  (The selected NSN is displayed 

                                  on the left corner of the status 

                                  bar.)

Forms: Demand Forecast            Displays the Demand Forecast window 

                                  for the selected NSN.  (The selected 

                                  NSN is displayed on the left corner 

                                  of the status bar.)

Forms: Demand History Process     Displays the Demand History Process 

                                  window for the selected NSN.  (The 

                                  selected NSN is displayed on the 

                                  left corner of the status bar.)

Forms: Depot Disposal Process     Displays the Depot Disposal Process 

                                  window for the selected NSN.  (The 

                                  selected NSN is displayed on the 

                                  left corner of the status bar.)

Forms: Due In Status              Displays the Due-In Status window 

                                  for the selected NSN.  (The selected 

                                  NSN is displayed on the left corner 

                                  of the status bar.)

Forms: National Inventory         Displays the National Inventory 

Record Inquiry                    Record Inquiry window for the 

                                  selected NSN.  (The selected NSN 

                                  is displayed on the left corner 

                                  of the status bar.)

Forms: Requirements Summary       Displays the Requirements Summary 

History                           History window for the selected 

                                  NSN.  (The selected NSN is displayed 

                                  on the left corner of the status 

                                  bar.)

Forms: Supply Control File        Displays the Supply Control File 

Header                            Header window for the selected 

                                  NSN.  (The selected NSN is displayed 

                                  on the left corner of the status 

                                  bar.)

FORMS MENU OPTIONS                PERFORM THESE FUNCTIONS
Forms: Supply Management Status   Displays the Supply Management

File Inquiry                      Status File Inquiry window for the 

                                  selected NSN.  (The selected NSN is 

                                  displayed on the left corner of the 

                                  status bar.)

Forms: Technical Data             Displays the Technical Data Record 

                                  submenu with the window choices 

                                  listed below on this table.  

                                  (The selected NSN is displayed on 

                                  the left corner of the status bar.) 

Forms: Technical Data             Displays the Technical Data Option A 

(Option A)                        Header/End-Item/PR Routing data. 

                                  (The selected NSN is displayed on 

                                  the left corner of the status bar.)

Forms: Technical Data             Displays the Technical Data Option B 

(Option B)                        PID Data. 

                                  (The selected NSN is displayed on 

                                  the left corner of the status bar.)

Forms: Technical Data             Displays the Technical Data Option C 

(Option C)                        TGI Data. 

                                  (The selected NSN is displayed on 

                                  the left corner of the status bar.)

Forms: Technical Data             Displays the Technical Data Option D 

(Option D)                        Technical History/Weapon System Data. 

                                  (The selected NSN is displayed on 

                                  the left corner of the status bar.)

Forms: Technical Data             Displays the Technical Data Option I 

(Option I)                        Contract History Buy Data Listing. 

                                  (The selected NSN is displayed on 

                                  the left corner of the status bar.)

Forms: Technical Data             Displays the Technical Data Option Q 

(Option Q)                        Missing Data Indicator. 

                                  (The selected NSN is displayed on 

                                  the left corner of the status bar.)

FORMS MENU OPTIONS                PERFORM THESE FUNCTIONS

Forms: Total Item Record (TIR)    Displays the Total Item Record 

                                  submenu with the window choices 

                                  listed below on this table.  (See 

                                  Figure 4.4 above.)  (The selected 

                                  NSN is displayed on the left corner 

                                  of the status bar.)

Forms: Total Item Record: Item    Displays the Item Identification

Identification (Seg A) Data       (Segment A) Data window for the 

                                  selected NSN.  (The selected NSN 

                                  is displayed on the left corner of 

                                  the status bar.)

Forms: Total Item Record: MOE     Displays the MOE Rule Coded (Segment 

Rule Coded (Seg B) Data           B) Data window for the selected NSN.  

                                  (The selected NSN is displayed on 

                                  the left corner of the status bar.)

Forms: Total Item Record: MOE     Displays the MOE Rule Decoded 

Rule Decoded (Seg B) Data         (Segment B) Data window for the 

                                  selected NSN.  (The selected NSN is 

                                  displayed on the left corner of the 

                                  status bar.)

Forms: Total Item Record:         Displays the Reference Number

Reference Number (Seg C) Data     (Segment C) Data window for the 

                                  selected NSN.  (The selected NSN is 

                                  displayed on the left corner of the 

                                  status bar.)

Forms: Total Item Record:         Displays the Standardization

Standardization (Seg E) Data      (Segment E) Data window for the 

                                  selected NSN.  (The selected NSN is 

                                  displayed on the left corner of the 

                                  status bar.)

Forms: Total Item Record:         Displays the Interchangeability

Interchangeability &              and Substitutability (Segment F)

Substitutability (Seg F) Data     Data window for the selected NSN.  

                                  (The selected NSN is displayed on 

                                  the left corner of the status bar.)

Forms: Total Item Record:         Displays the Freight (Segment G)

Freight (Seg G) Data              Data window for the selected NSN.  

                                  (The selected NSN is displayed on 

                                  the left corner of the status bar.)

Forms: Total Item Record:         Displays the Management (Segment H)

Management (Seg H) Data           Data window for the selected NSN.  

                                  (The selected NSN is displayed on 

                                  the left corner of the status bar.)

4.4.1  SELECTING AN NSN AND DISPLAYING A FORM (NEW SEARCH KEY OPTION) 

  a.  The first option on the Forms drop-down menu of the DSE – Item Data Folder, Select New Key Search, is used to choose the NSN for the form that you wish to query.  The NSN that you select is retained as the default value for the NSN until you perform the Select New Key Search option again.

  b.  To select an NSN:

    (1) Select Forms from the menu bar on the DSE – Item Data window (Figure 4.2) by clicking on it or by depressing the ALT and O at the same time.  A drop-down menu appears.  Go to step b, or

    (2) Select the key icon from the menu bar and go to step c.

  b. Select the New Search Key option by clicking on it or by depressing K.  The system displays the Current Search Key window.  
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               FIGURE 4.4.1A - CURRENT SEARCH KEY WINDOW

    (3) Type in the NSN that you would like to search by.

    (4) Select the OK button.  The system displays the DSE – Item Data window with the newly entered NSN displayed on the lower left-hand corner of the status bar.

    (5) Select the form to be displayed from the Forms drop-down menu.  The system displays the form for the NSN selected.
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        FIGURE 4.4.1B - SUPPLY MANAGEMENT STATUS FILE INQUIRY WINDOW

    (6) To display data on the Requirements Summary History window, you must select a Recommended Buy from the drop-box.  Data is not displayed until a Recommended Buy (RB) is selected.  If the Memo field is darkened, select the Memo button to display the memo data.  For forms other than the Requirements Summary History window, this step is not applicable. 

    (7) For a full name description of what a field is displaying, use the mouse to point to a field name.  The system describes what is being displayed.  For example, in Figure 4.4.1B above, the mouse arrow was pointing to the Depot field.  The system supplies a text box that says Storage Location Routing Identification Code.  

4.4.2  MOVING FIELDS ON SPREADSHEET FORMS 

  a.  It is possible to rearrange the order of fields on forms that are displayed in a spreadsheet format, such as the Customer Returns History Process form.

  b.  To move a field on a form:

    (1) Use the mouse to point to the header of the column that you wish to move. 

    (2) Click and hold down the left mouse button.  The system will display a double-headed arrow (<->).  

    (3) Place the arrow where you wish to move the column.  Then, release the button.  The system will shift the other columns to move the column to the new location.  The system does not save the changed order of the fields.

4.4.3  STRETCHING SCREENS TO SHOW MORE DATA

  a.  Some windows are too small to display all of the columns of data at the same time.  It is possible to stretch the window to show as many columns as possible at the same time.  This option is available on windows such as the Demand History Process form.  If a screen can be stretched, the window will have an arrow in the lower right corner of the window as pointed out in Figure 4.4.3A below.

                                  Stretching can remove this gray area.


[image: image10.wmf]
   FIGURE 4.4.3A - SHOWS A FORM THAT MAY BE STRETCHED (NOTE THE ARROW)

  b.  To Stretch The Window:

    (1) Use the mouse to point to the arrow on the right corner of the status bar as pointed out in Figure 4.4.3A above.

    (2) Click and drag the arrow to size the window to fit the screen.
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        FIGURE 4.4.3B - SHOWS THE WINDOW ABOVE AFTER STRETCHING

Notice that the gray area around the window in Figure 4.4.3A no longer exists in Figure 4.4.3B.  

    (3) To fit even more columns on the window, shrink the column headers to fit the width of the data.  (Click and drag the lines between the headers to move the lines.)

4.4.4  SORTING BY A COLUMN ON A SPREADSHEET FORM

  a.  Windows that are displayed in a spreadsheet format, such as the Due-In Status form, may be sorted by column.

  b.  To sort by column:

    (1) Use the mouse to point to the column header on which you wish to sort.

    (2) Left click on the column header.  The system will display the rows sorted by the selected column in ascending order.

4.5  ACCESSING ADD-INS OPTIONS ON THE DSE – ITEM DATA WINDOW

  a.  The Add-In menu provides the ability to execute other applications while in the Folders application.  Use the Add-In Manager to pull the executable files from other applications accessible from your hard drive into the Folders application.  

  b.  To access the Add-Ins drop-down menu on the DSE – Item Data window:

    (1) On the DSE – Item Data window, select Add-Ins from the menu bar by clicking on it with the mouse or by depressing ALT and A on your keyboard.  The following drop-down menu appears.
[image: image12.png]2 Addin Manager





      FIGURE 4.5 - DSE – ITEM DATA WINDOW ADD-INS DROP-DOWN MENU

    (2) Select the desired application to run an application on the menu or select Add-In Manager to add a new application to the Add-Ins drop-down menu.

4.5.1  USING THE ADD-IN MANAGER TO ADD APPLICATIONS TO THE ADD-IN MENU

  To use the Add-In Manager:

  a.  Select the Add-In Manager option from the Add-In drop-down menu on the DSE – Item Data window.  (The icon is pictured beside the Add-In Manager option in Figure 4.5.)  The system displays the left side of the Application Add-In Manager window (Figure 4.5.1A).
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           FIGURE 4.5.1A - APPLICATION ADD-IN MANAGER WINDOW

  b.  Select the Add option to add a new application to the Add-In menu bar.  The system displays the full Application Add-In Manager window.
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  FIGURE 4.5.1B - APPLICATION ADD-IN MANAGER WINDOW (ADD APPLICATION)

  c.  Select the drive that contains the executable you wish to add to the menu.  Click on the arrow beside the drive to display a drop-box with drive choices as pictured Figure 4.5.1B.  (If you are trying to establish a web link, select the drive where the web browser is located.)  The left-hand side of the window is similar to Microsoft Windows Explorer. 
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         FIGURE 4.5.1C - ADD-IN MANAGER WINDOW  (ADD WEB LINK)

  d.  Select the sub-directory where the application or web browser is located by double-clicking on the folders icons under the Folders heading.  (Double-click on an open folder to close it.  Double-click on a closed folder to open it.)  Notice that system displays the executable files for the open subdirectory.  

  e.  Double-click on the executable file that you wish to be added to the Add-In drop-down menu.  The system will display the executable file name in the Application Executable box as shown in Figure 4.5.1B.

  f.  Complete the MENU NAME FOR ADD-IN APPLICATION block with the name that you wish to have displayed on the Add-Ins drop-down menu.

  g.  Complete the SPECIFIC FILE OR WEB LINK THAT AUTOMATICALLY EXECUTES block with the correct web link if applicable.  (This step is mandatory for web links.  If you have followed the steps a through f for adding a specific file, this step will not be necessary for adding a non-web application.)

  h.  Select the Add to Add-In Menu button.  The system places the newly added application or web link under the Add-Ins heading.  
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FIGURE 4.5.1D - APPLICATION ADD-IN MANAGER WINDOW (NEWLY ADDED WEB 

                LINK)

  i.  Select the OK button.  The system adds the new application to the Add-Ins drop-down menu.  (The system does not save information on the Add-In Manager window unless OK is selected.)
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      FIGURE 4.5.1E - ADD-INS DROP-DOWN MENU (NEWLY ADDED WEB LINK)

The table below explains the functions of the buttons on the Add-In Manager window.

BUTTONS            PERFORM THESE FUNCTIONS

OK                 Adds the application to the Add-Ins drop-down menu

                   once the necessary information is completed on the 

                   Add-In Manager window. 

Cancel             Exits the Add-In Manager window without putting the 

                   new application on the menu.  (Unless the applica-

                   tion is added to the menu, the information on the 

                   Add-In Manager window will not be saved.)  Returns 

                   to the Folder Explorer window.

BUTTONS            PERFORM THESE FUNCTIONS

Update             Allows the fields on the Add-In Manager window 

                   related to the selected application to be updated.  

                   (See section 4.5.2.)

Add                Brings up additional fields for the Add-In Manager 

                   window.  These fields allow an application 

                   executable to be added to the Add-Ins drop-down menu 

                   on the DSE – Item Data window.  (See section 

                   4.5.1.)

Add to Add-In      Adds the application name and check box to the Add-

Menu               Ins column on the Application Add-In Manager window.  

                   (See section 4.5.1g.)

Cancel Add-In      Cancels the addition of the new application.  

                   Returns to the abbreviated Application Add-In 

                   Manager window as shown in Figure 4.5.1A.

Update Add-In      Applies the updates made on the Application Add-In 

Menu               Manager window.  The changes will not be saved 

                   unless the OK button is selected.  (See section 

                   4.5.2e.)

Cancel Update      Cancels the update of the selected application.  

                   Returns to the abbreviated Application Add-In 

                   Manager window as shown in Figure 4.5.1A.

4.5.2  USING THE ADD-IN MANAGER TO UPDATE AN APPLICATION ON THE ADD-IN 

       MENU

  To update the information on the Application Add-In Manager window:

  a.  Select Add-In Manager from the Add-Ins drop-down window.  The system displays the Application Add-In Manager window. 

  b.  Highlight the application to be updated.

  c.  Select the update button.  The system displays additional fields for the application which may be changed.
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       FIGURE 4.5.2 - APPLICATION ADD-IN MANAGER WINDOW (UPDATES)

  d.  Change any field except the MENU NAME ADD-IN APPLICATION block.  (See Figure 4.5.2.)  Notice that the Button at the bottom of the window says Update Add-In Menu as opposed to Add Add-In Menu.

  e.  Select the UPDATE ADD-IN MENU button to save the changes made.

or select the CANCEL UPDATE button to return to the abbreviated 

Application Add-In Manager window without making changes.

  f.  Select OK to apply the updates to the selected application.  (If OK is not selected, changes will not be saved once the Application Add-In Manager window is exited) or select CANCEL to cancel the updates and exit to the DSE – Item Data window without saving changes.

4.5.3  USING THE ADD-IN MANAGER TO DELETE AN APPLICATION ON THE 

       ADD-IN MENU

  To delete an application from the Add-In drop-down window:

  a.  Click on the application’s check box on the Application Add-In Manager window to deselect the application that is being removed.  The check will be removed from the check box as shown in Figure 4.5.3 below.  Notice that DLAZIP doesn’t have a check in the check box.
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  FIGURE 4.5.3 - APPLICATION ADD-IN MANAGER (DELETING AN APPLICATION)

  b.  Click OK to remove the application from the Add-Ins drop-down menu or click on the check box to recheck the application and select the CANCEL button to exit the window without removing the application.

4.6  ACCESSING THE WINDOW DROP-DOWN MENU ON THE DSE – ITEM DATA

     WINDOW

  a.  The Windows drop-down menu has multiple functions.  Use this menu to arrange open forms on the DSE – Item Data window or to arrange icons.  In addition, this form displays the names of the open windows along with the NSN.  This last feature is important.  If you open multiple forms for various NSNs, the Window drop-down window is the only method of accessing a window that displays the NSN associated with the window.  The ALT-TAB feature and the window names at the bottom of DSE – Item Data window do not list the NSNs. 

  b.  To access Window options:

    (1) On the DSE – Item Data window, select Window from the menu bar by clicking on it with the mouse or by depressing ALT and W on your keyboard.  The following drop-down menu appears.
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          FIGURE 4.6A - DSE – ITEM DATA WINDOW DROP-DOWN MENU

    (2) Select the desired option from the table below.  The table lists the functions on the Window drop-down menu of the DSE – Item Data window. 

WINDOW MENU OPTIONS                 PERFORM THESE FUNCTIONS
Window: Tile Horizontally           Displays the open form windows with 

                                    the width of the screen visible on 

                                    the DSE – Item Data window.  The 

                                    windows will be stacked one below 

                                    the other.  (See Figure 4.3B.) 

Window: Tile Vertically             Displays the open form windows with 

                                    the length of the screen visible.  

                                    The windows will be displayed side 

                                    by side.  (See Figure 4.3C.)

Window: Cascade                     Arranges the open windows so that 

                                    title bar of each window is 

                                    visible.  The only fully visible 

                                    window is the active window.  (See 

                                    Figure 4.3D.)

WINDOW MENU OPTIONS                 PERFORM THESE FUNCTIONS
Window: Arrange Icons               Arranges the icons on the menu bar.  

                                    (It is possible to drag the icons 

                                    to other locations on the menu bar.  

                                    This option will arrange the spac-

                                    ing between the menu bar options.)

Window: Select Window               Click on a window name to select it 

                                    as the active window.  The active 

                                    window will have a check mark 

                                    preceding its title.
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                     FIGURE 4.6B - TILE HORIZONTALLY
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                      FIGURE 4.6C - TILE VERTICALLY
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                         FIGURE 4.6D - CASCADE

4.7  ACCESSING HELP OPTIONS ON THE DSE – ITEM DATA WINDOW

  Help is not yet functional. 

SECTION 5  THE WEB BROWSER

5.1  ACCESSING REPORTS ON THE WEB BROWSER

  a.  The Folders Application supports either a Netscape or a Microsoft web browser.  To access reports on the web, use the Reference Reports option on the Add-Ins drop-down menu.  (See section 4.5.)  The system displays the following window.
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                 FIGURE 5.1A - WEB BROWSER ENTRY WINDOW

  b.  To access Electronic Business Folder reports, click on the underlined narrative at the bottom of the window shown in Figure 5.1A that says Continue to the Electronic Business Folders.  The system displays the EBF (Electronic Business Folders) Report Files window below.  (The User Help Screen option displays online help for the Folders web application.)
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                 FIGURE 5.1B - EBF REPORT FILES WINDOW

  c.  To display a report:

    (1) Click the white dot in front of the report.  The system blacks in the dot.

    (2) Then, click the View button at the end of the file.  (Depress CTRL  END at the same time to go to the end of the file.)  The system displays a query window.
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     FIGURE 5.1C - BACKORDERS > 20 DAYS WITH NO DUES-IN QUERY WINDOW

  d.  The example above in Figure 5.1C shows the query window for the Backorders > 20 Days with No Dues-In report.  (The Back button on the window takes you back to the window that was displayed before the current window.  In this case that would be Figure 5.1B.) 

  e.  The table below explains the functions of the buttons on the Address Report Query window.  Other reports will have the same options.

BUTTONS            PERFORM THESE FUNCTIONS
Submit             Submits the query to the system.  The system 

                   displays the report.

Select All         Checks the boxes preceding all fields, so that they 

                   will be displayed on the report.

Deselect All       Removes the check marks from the boxes preceding all 

                   fields.  This allows you to reselect only the fields 

                   you wish to see.

Back               Redisplays the previous window.  

5.2  USING THE QUERY FEATURE FOR A REPORT

  a.  When viewing data elements in a report, you can select the elements that you wish to view.  You also have the option to sort on any data element in the report in either ascending or descending order.  The default for the browser will select all of the data elements and display them with no sort. In addition to the above options, you can elect to view limit your viewing to where one or more data element(s) are equal to specified values, or are greater than or less than the specified values.

  b.  To make a customized query:

    (1) Select the fields that you wish to be displayed.  All fields are initially selected.  A check mark appears in the box preceding a selected field.  To deselect the field, click the box with the check mark; or use the Deselect All button at the bottom of the window to deselect all fields, then reselect the fields you wish to see by clicking on the check mark box.

    (2) To limit the values displayed for a field, click the arrow in the drop-box following the equal sign for the field.  Choices are equals (=), is greater than (>), or is less than (<).  Select one of these values.

    (3) Place your cursor in the field following the =, >, or < sign.

    (4) Type in the field value for which you wish to search.

    (5) The last box in the row displays the word AND.  You also have the option of selecting OR.  Click the down arrow following AND to display all options.  If desired, click OR to select it.  

    (6) Repeat steps 2 through 5 for other fields if desired.

    (7) Click the Submit button.  The system displays the report.

      (a) In the example below, the report was customized to display all fields by ORC in ascending order.  Notice that the system displays ten records at a time.  Select the Next Records button at the bottom of the window to display the next ten records.
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        FIGURE 5.2 - BACKORDERS > 20 DAYS WITH NO DUES-IN REPORT

      (b) The table below explains the functions of the buttons on the Address Report window.  Other reports will have the same options.

BUTTONS            PERFORM THESE FUNCTIONS
Next Records       Displays the next ten records.

New Search         Redisplays the query screen shown in Figure 5.1C to 

                   allow a new search to be initiated.

New Report         Redisplays the EBF Reports menu shown in Figure 

                   5.1B.

Back               Redisplays the prior ten records.  This  button will 

                   not appear until you have used the Next Records 

                   button.  
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